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Plastyczne postaci

W jaki sposób stworzyæ postaæ, 
której powierzchnia jest bardziej nierówna 

ni¿ w przypadku typowych trójwymiarowych postaci?

Temat: modelowanie, rendering

Zastosowane techniki oraz narzêdzia: Subdivision Surfaces, Split Polygon Tool, 
Extrude Faces, Displacement Shader

Wiêkszoœæ trójwymiarowych obiektów sk³ada siê z nienaga-

nnie wyprofilowanych powierzchni, które nie nadaj¹ siê do pew-

nych zastosowañ. Typowym rozwi¹zaniem problemu zamode-

lowania szorstkiej, nierównej powierzchni s¹ mapy wypuk³oœci

(ang. Bump Maps). W rzeczywistoœci mapy wypuk³oœci nie ma-

j¹ zbyt wiele wspólnego z powierzchni¹, a raczej z kamer¹. 

W wiêkszoœci przypadków technika ta jest wystarczaj¹ca i bard-

zo skraca czas renderingu. Jednak¿e kiedy potrzebne s¹ kon-

trastuj¹ce z otoczeniem, bardzo wyraŸnie zaznaczone deformac-

je i wypuk³oœci, opisana technika nie jest przydatna.

W takim przypadku warto zwróciæ uwagê na technikê zwan¹

mapa przemieszczenia (ang. Displacement Mapping), poniewa¿

deformacja powierzchni nie jest symulowana. Zniekszta³cenie

powierzchni odbywa siê przez wykorzystanie szarych tonów

tekstury lub obrazu. Niestety, tego typu zniekszta³cenia nie s¹

widoczne w widoku modelowania. Nale¿y je zrenderowaæ.

Ten rozdzia³ sk³ada siê z dwóch czêœci, które s¹ ze sob¹ po-

wi¹zane. Rozpoczniemy od wykorzystania techniki pod-

podzia³u p³aszczyzn w celu wymodelowania wysokiego,

szczup³ego mê¿czyzny o ma³ej g³owie. Przy odrobienie prakty-

ki taka czynnoœæ zajmuje kilka minut (w przeciwnym wypadku

zajê³oby to co najmniej godzinê). Jeœli nie posiadamy wersji

Maya Unlimited, podobny efekt mo¿na uzyskaæ korzystaj¹c 

z tych samych narzêdzi do dzielenia i g³êbi oraz polecenia

Polygons > Smooth. Osoby, które wol¹ pomin¹æ lub od³o¿yæ

etap modelowania postaci, mog¹ utworzyæ dowolny prymityw

graficzny i przeanalizowaæ dalsz¹ czêœæ rozdzia³u.

1. Utwórz szeœcian wieloboczny.

2. Wybierz polecenie Polygons to Subdiv z menu Modify 

> Convert, by utworzyæ podpodzia³y p³aszczyzn szeœcianu.

3. Przypisz nowy materia³ dla utworzonych powierzchni.

Jeœli przez przypadek pokry³eœ tekstur¹ szeœcian (który jest 

w tym przypadku zewnêtrzn¹ skór¹ powierzchni nowych p³aszczy-

Rysunek 10.1. Szeœcian wieloboczny,
na którym zastosowano podpodzia³
p³aszczyzn; menu podrêczne sprawia,
¿e widoczny jest oryginalny wielobok
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zn, a nie sam¹ powierzchni¹) zamiast utworzonych p³aszczyzn,

nale¿y cofn¹æ operacjê. Zaznacz rzeczywist¹ powierzchniê

nowych p³aszczyzn (polyToSubdShape1) (mo¿na to zrobiæ miê-

dzy innymi w oknie Hypergraph) przed ponownym na³o¿e-

niem materia³u. Poni¿sze czynnoœci mo¿na wykonaæ, klikaj¹c

nowy podpodzia³ prawym klawiszem myszy i wykorzystuj¹c

menu kontekstowe.

4. Prze³¹cz siê na tryb Polygon (patrz rysunek 10.1).

Podzielone p³aszczyzny mo¿na modelowaæ na dwa ró¿ne sposo-

Rysunek 10.2. Korzystaj¹c 
z narzêdzia Split Polygon Tool,
mo¿na podzieliæ doln¹ czêœæ 
œcianki szeœcianu na dwie czêœci

Rysunek 10.3. Narzêdzie Extrude Tool
pozwala uzyskaæ odpowiedni¹ g³êbiê
i gêstoœæ definicji geometrii; 
œcianka szeœcianu jest doskona³ym 
materia³em do zamodelowania nóg

Rysunek 10.4. Po kilkukrotnym 
zastosowaniu g³êbi nogi s¹ gotowe;
mo¿e nie s¹ doskona³e, ale to bez
w¹tpienia nogi; ostatnia g³êbia
(tym razem w poziomie) pos³u¿y 
do wymodelowania stóp

Rysunek 10.5. Stopy warto 
modelowaæ w widoku bocznym 
w celu uzyskania wiêkszej precyzji

Rysunek 10.6. Dolna czêœæ postaci
jest gotowa – odrobina praktyki
pozwala uzyskaæ taki efekt 
w przeci¹gu kilku minut
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Rysunek 10.7. Modelowanie górnej
czêœci cia³a; zastosowanie dwóch
pierwszych g³êbi w celu wymode-
lowania ramion

by. Jeden z nich polega na

wykorzystaniu narzêdzi z grupy

wieloboków, drugi na zastoso-

waniu narzêdzi typu Nurbs.

Klasyczne narzêdzia z grupy

wieloboków nadaj¹ siê idealnie

do uzyskania wiêkszej rozdziel-

czoœci geometrycznej (na przy-

k³ad na obszarze, w którym nogi

wy³aniaj¹ siê z torsu). Z tego po-

wodu wiêksz¹ czêœæ modelowa-

nia wykonamy w trybie Polygon.

1. Z menu Edit Polygons wy-

bierz polecenie Split Poly-

gon Tool, by podzieliæ

doln¹ czêœæ œcianki szeœ-

cianu na pó³ (patrz rysu-

nek 10.2). Nie trzeba tu

d¹¿yæ do zbyt wielkiej

precyzji – podzia³ nie musi

byæ dok³adny, poniewa¿

nasza postaæ nie bêdzie

bra³a udzia³u w konkursie

piêknoœci. ZatwierdŸ po-

dzia³ przez naciœniêcie kla-

wisza Enter.

2. Pos³uguj¹c siê menu pod-

rêcznym, ponownie wyœ-

wietl p³aszczyzny. Zaznacz

dwie w³aœnie utworzone

dolne p³aszczyzny szeœcia-

nu. Wybierz polecenie Ex-

trude Face z menu Edit

Polygons, by z tych p³asz-

czyzn utworzyæ nowe obiek-

ty geometryczne. Klikniê-

cie jednego z skaluj¹cych

szeœcianów narzêdzia spra-

wia, ¿e narzêdzie przecho-

dzi w tryb skalowania.

Przeskaluj równoczeœnie

obie p³aszczyzny w dó³.

Pos³uguj¹c siê strza³k¹ (tego

narzêdzia) przemieœæ p³asz-

czyzny odrobinê w dó³.

3. Nie zmieniaj¹c zaz-

naczenia obiektów, naciœnij

Rysunek 10.8. Zastosowanie 
dwóch pierwszych g³êbi w celu
wymodelowania szyi oraz g³owy

Rysunek 10.10. Menu podrêczne 
podpodzia³u p³aszczyzn pozwala
prze³¹czaæ siê pomiêdzy ró¿nymi
poziomami hierarchii; szczegó³y
wymagaj¹ce wiêkszej precyzji 
i dopracowania mo¿na edytowaæ 
na poszczególnych p³aszczyznach

Rysunek 10.9. Obrót tylnej czêœci
g³owy
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klawisz G, by ponownie zastosowaæ polecenie g³êbi, tym

razem do nowoutworzonych p³aszczyzn. W ten sam sposób

utwórz nogi (powtarzaj¹c to polecenie dwa lub trzy razy).

Przy ostatnim zastosowaniu polecenia g³êbi utwórz

p³aszczyzny, z których mo¿na bêdzie wymodelowaæ stopy

(patrz rysunek 10.4).

4. Podczas skalowania i stosowania g³êbi na stopach korzystaj

z widoku bocznego oraz górnego, by pracowaæ bardziej pre-

cyzyjnie (patrz rysunek 10.5).

1. Ponownie zastosuj narzêdzie Split Polygon Tool, by z torsu

wymodelowaæ ramiona (oraz ewentualnie palce). Polecenie

g³êbi dzia³a w sposób symetryczny, dlatego mo¿na równo-

czeœnie modelowaæ lewe i prawe ramiê (patrz rysunek 10.7).

2. Zastosuj g³êbiê na górnej p³aszczyŸnie podpodzia³u,

przeskaluj w dó³ w kierunku szyi i rozpocznij modelowanie

szyi oraz g³owy (patrz rysunek 10.8).

3. SprawdŸ ca³¹ postaæ, dostosowuj¹c p³aszczyzny wed³ug

w³asnego gustu. Warto pamiêtaæ, ¿e oprócz przemieszczania

i skalowania, p³aszczyzny mo¿na równie¿ obracaæ (patrz

rysunek 10.9).

W oknie dialogowym Channel Box widaæ, ¿e po wykonaniu

wszystkich efektów g³êbi, historia tworzenia powierzchni zawie-

ra o wiele wiêcej danych, ni¿ potrzeba. Usuniêcie historii za po-

moc¹ polecenia History z menu Edit > Delete by Type skutku-

je nieznacznym rozjaœnieniem ca³ej sceny.

Rysunek 10.11. Oto, jak mo¿na
utworzyæ mapê przemieszczenia 
z trójwymiarowej tekstury za pomoc¹
projekcji; wystarczy otworzyæ okno
Attribute Editor dla grupy cienia,
klikn¹æ ikonê szachownicy 
i zlokalizowan¹ obok pola
Displacement Map, nastêpnie 
w oknie Create Render Node wybraæ
opcjê As projection; jedna z tekstur,
której zastosowanie mo¿na rozwa¿yæ
to tekstura o nazwie Solid Fractal
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Rysunek 10.12. Te dwie postaci
cechuj¹ siê tak¹ sam¹ geometri¹ oraz
tekstur¹; jedyn¹ ró¿nic¹ jest sposób
na³o¿enia tekstury; nierównoœci
postaci na pierwszym planie zosta³y
wygenerowane za pomoc¹ mapy
wypuk³oœci, natomiast postaæ w tle
powsta³a dziêki zastosowaniu mapy
przemieszczenia; krawêdzie postaci 
na pierwszym planie s¹ g³adkie, 
ale mapa przemieszczenia sprawia, 
¿e sylwetka drugiej postaci zawiera
wiele wybrzuszeñ; mimo ¿e nie by³y
zmieniane ¿adne ustawienia 
mapowania, mapa przemieszczenia
powoduje znacz¹ce pogrubienie
postaci, natomiast mapa
wybrzuszenia praktycznie nie zmienia
rozmiarów modelowanej postaci

Rysunek 10.14. Trójwymiarowy 
obiekt przemieszczenia przykrywa
ca³¹ postaæ; z lewej strony widaæ 

zrenderowan¹ scenê; ikona zakreœlona
na rysunku pozwala zapisaæ 

zrenderowany obraz w pamiêci; 
obraz zostanie usuniêty dopiero 
po zamkniêciu programu Maya 

(lub na skutek jego awarii)

Rysunek 10.13. Szkielet szeœcianu 
u stóp postaci okreœla rozmiary mapy
przemieszczenia; im mniejszy 
szeœcian, tym czêœciej tekstura 
jest powtarzana na obiekcie

To, czego nie mo¿na usun¹æ, to to¿samoœæ podpodzia³u po-

wierzchni. Pos³uguj¹c siê menu podrêcznym oraz poleceniami

Coarser i Finer, mo¿na prze³¹czyæ siê z jednego poziomu hier-

archii na nastêpny w celu pracy globalnej lub lokalnej z po-

wierzchniami w trybie wieloboku lub standardowym (patrz ry-

sunek 10.10).

Nie trzeba dodawaæ zbyt wielu szczegó³ów na tym etapie, np.

nosa, ³opatek lub palców u nóg. Narzêdzie Displacement Shader

mo¿e usun¹æ tego typu szczegó³y.
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Rysunek 10.15. Okno Attribute Editor;
w górnej czêœci widaæ parametry
odpowiedzialne za strukturê fraktali; 
w dolnej czêœci znajduj¹ siê 
ustawienia dla skali szaroœci; 
to w³aœnie te barwy s¹ odpowiedzialne
za stopieñ zniekszta³cenia obiektu;
g³ówne parametry zwi¹zane z map¹
przemieszczenia to Color Gain oraz
Alpha Gain; wy¿sze wartoœci 
oznaczaj¹ wiêcej bieli, co z kolei 
powiêksza postaæ; kiedy obiekt 
zawiera g³ównie czarny kolor, 
geometria obiektu pozostaje 
bez zmian

1. Kliknij ikonê znajduj¹c¹ siê obok parametru Displacement

Mat w oknie Attribute Editor z w³aœciwoœciami grupy

cienia powierzchni.

2. Otwarte zostanie okno Create Render Node (patrz rysunek

10.11). W tym miejscu wybierz teksturê, która spowoduje

deformacjê postaci na podstawie jej szarych wartoœci, mo¿e

to byæ na przyk³ad tekstura o nazwie Solid Fractal. Jako

metodê mapowania wybierz opcjê As projection. Opcja ta

odpowiada za równomierne roz³o¿enie tekstury na

powierzchni ca³ego obiektu.

l Poniewa¿ w widoku modelowania nie widaæ ¿adnych

zmian, pora zrenderowaæ scenê.

Rendering potrwa chwilê, mo¿e to byæ nawet kilka minut 

w zale¿noœci od geometrii, zastosowanego materia³u oraz mocy

obliczeniowej komputera. Otrzymany rezultat jest znakomit¹

ilustracj¹ ró¿nic pomiêdzy map¹ przemieszczenia a map¹

wypuk³oœci. Na rysunku 10.12 postaæ na pierwszym planie

zosta³a pokryta tekstur¹ o nazwie Solid Fractal podobnie jak

postaæ w tle, ale w drugim przypadku tekstura zosta³a znieksz-

ta³cona za pomoc¹ mapy przemieszczenia. Powierzchnia postaci

na pierwszym planie jest dosyæ nieregularna, ale jej krawêdzie s¹

zupe³nie g³adkie.

Efekt zastosowania mapy przemieszczenia zale¿y od rozmi-

arów tworzonej postaci. Istniej¹ dwie mo¿liwoœci dostosowania

si³y efektu. Jedn¹ z nich jest zmiana gêstoœci, z jak¹ tekstura jest

mapowana na obiekt. W widoku modelowania widaæ szkielet

szeœcianu o nazwie place3dTexture1. Jest to jedno z narzêdzi,

które pozwala wprowadziæ zmiany (patrz rysunek 10.13). 

Drugi sposób dostosowania tekstury przemieszczenia to wyko-

rzystanie szarych wartoœci tekstury. Mapa przemieszczenia, podob-

nie jak mapa wybrzuszenia, wykorzystuje tylko wartoœci œwiat³a

(kana³ alfa) tekstury w celu wygenerowania zniekszta³ceñ geome-

trycznych. W przypadku wiêkszoœci tekstur opcje skali szaroœci

mo¿na znaleŸæ w czêœci Color Balance w oknie Attribute Editor.

Najpierw zacznijmy od ciemnych, niemal czarnych wartoœci

kolorów oraz bardzo niskiej wartoœci parametru Alpha Gain (patrz

rysunek 10.15).

Aby zwiêkszyæ rozmiar postaci, wystarczy zastosowaæ jasn¹

teksturê. Jeœli obiekt nie jest zbytnio oœwietlony, mapa prze-

mieszczenia pozostawia go bez zmian. Jeœli tekstura uwydatnia

wyraŸne zmiany w natê¿eniu œwiat³a, postaæ bêdzie bardzo wy-

brzuszona, a jasne obszary tekstury bêd¹ odpowiadaæ wypuk-

³oœciom obiektu.

Zazwyczaj jedynie metod¹ prób i b³êdów mo¿na ustaliæ w³aœ-

ciw¹ kombinacjê ustawieñ umo¿liwiaj¹cych uzyskanie zamie-

rzonego efektu. Niestety IPR nie obs³uguje map przemieszczenia,

co oznacza przed³u¿ony okres renderingu. Ewentualnym rozwi¹-
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zaniem jest rendering mniejszych obszarów obrazu lub tylko jego

czêœci.

Dziêki modelowaniu podpodzia³ów oraz mapom przemiesz-

czenia mamy do dyspozycji dwa potê¿ne narzêdzia pozwalaj¹ce

wydajnie tworzyæ z³o¿one postaci, które wygl¹daj¹ jakby zosta³y

ulepione z gliny (patrz rysunek 10.16) lub odlane ze z³ota (patrz

rysunek 10.18). Aby utworzyæ lepszej jakoœci teksturê, mo¿na

dodaæ mapê wypuk³oœci oprócz mapy przemieszczenia.

Wypuk³oœci mog¹ wtedy dzia³aæ jako niewielkie deformacje na

wiêkszych zniekszta³ceniach.

Proces modelowania sprawia, ¿e dystrybucja wspó³rzêdnych

UV texture jest bardzo nierówna. By³oby to widoczne, gdyby

zamiast opcji Projection wybrana zosta³a metoda mapowania

typu Normal. Aby rozwi¹zaæ problemy zwi¹zane z dystrybucj¹

tekstury, nale¿y utworzyæ now¹ mapê tekstur UV, np. zastosowaæ

polecenie Automatic Mapping, które znaleŸæ mo¿na w menu

Subdiv Surfaces.

Projekcja tekstury podobna do modelowanej nie wi¹¿e siê ze

wspó³rzêdnymi UV. Ale z chwil¹ rozpoczêcia animacji postaci,

konieczne bêdzie na³o¿enie tekstury na obiekt. W przeciwnym

przypadku, kiedy postaæ bêdzie siê poruszaæ, ³atwo o z³udzenie,

¿e postaæ przenika przez teksturê. Polecenie pozwalaj¹ce przyk-

leiæ teksturê do obiektu nazywa siê Convert to File Texture

i mo¿na je znaleŸæ w menu Edit. Jeœli chcemy zastosowaæ z³o-

¿one narzêdzia do mapowania tekstury, mo¿emy zastosowaæ

polecenie Sudiv to Polygons z menu Modify > Convert.

Rysunek 10.16. Postaæ, która wygl¹da
na ulepion¹ z gliny

Dla odmiany:
Czy nacisn¹³eœ ostatnio 

klawisz A lub F?
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Rysunek 10.18. Postaæ odlana ze z³ota

Rysunek 10.17. Postaæ wykuta z metalu
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B³otnik samochodowy

W jaki sposób mo¿na 
wymodelowaæ b³otnik samochodowy 

za pomoc¹ kilku krzywych typu Nurbs?

Temat: modelowanie

Zastosowane techniki oraz narzêdzia: Loft, Square, Birail

Samochodowe b³otniki bardzo rzadko powstaj¹ niezale¿nie

od samochodów. Kszta³t b³otnika jest nieod³¹czon¹ czêœci¹ ogól-

nego wygl¹du samochodu. Niemniej projektowanie b³otnika jest

dobrym æwiczeniem, pozwalaj¹cym tworzyæ bardzo specyficzne

kszta³ty za pomoc¹ specjalnych krzywych.

W tym rozdziale bêdziemy niemal wy³¹cznie tworzyæ i mody-

fikowaæ krzywe. Nastêpnie utworzymy z nich powierzchnie,

które usuniemy po krótkim omówieniu. Rozpoczniemy od dwóch

krzywych, które utworz¹ p³aszczyznê, nastêpnie pos³u¿ymy siê

narzêdziem Square, a na koniec zastosujemy narzêdzie Birail 3+.

Narzêdzie to pozwala tworzyæ powierzchnie w oparciu o dwie

krzywe wiod¹ce oraz kilka krzywych profilu. To praktycznie je-

dyna powierzchnia, któr¹ zachowamy. Rozpoczêcie od najbar-

dziej zaawansowanego narzêdzia nie jest najlepszym pomys³em.

Pierwsza prosta p³aszczyzna zawiera doskona³e krzywe

umo¿liwiaj¹ce tworzenie lepszych powierzchni.

1. Korzystaj¹c z narzêdzia EP Curve Tool, za pomoc¹ oko³o

oœmiu klikniêæ utwórz prost¹ krzyw¹ wzd³u¿ osi X.

2. Skopiuj krzyw¹ i przesuñ kopiê w górê.

Rysunek 11.1. P³aszczyzna rozci¹ga
siê pomiêdzy dwoma równoleg³ymi
krzywymi; program pozwala na
od³¹czenie powierzchni od krzywych
(ikona zosta³a zakreœlona na rysunku);
dziêki temu edytuj¹c krzywe, nie 
zaznaczymy przypadkowo powierzchni

Rysunek 11.2. Górna czêœæ
przestrzeni na ko³o zosta³a 
wymodelowana za pomoc¹ narzêdzia
Proportional Modification Tool; 
ma ono silniejszy wp³yw 
na punktu kontrole w œrodku 
ni¿ na krawêdziach 
zaznaczonej krzywej.
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3. Wybierz F3, Surfaces > Loft, by utworzyæ powierzchniê 

z tych dwóch krzywych.

4. Kliknij ikonê Surfaces, dziêki czemu od tej pory bêdzie mo¿na

zaznaczaæ same krzywe (patrz rysunek 11.1). Oczywiœcie po-

wierzchnie nadal mo¿na zaznaczaæ w oknie Outliner.

5. Wybierz polecenie Proportional Modification Tool z menu

Modify > Transformation Tools, by przesun¹æ œrodkowe

punkty kontrolne dolnej krzywej w górê. Punkty te pozwala-

j¹ na zmianê kszta³tu b³otnika tworz¹c miejsce na ko³o (patrz

rysunek 11.2).

6. Przeskaluj punkty kontrolne po³o¿one z lewej i prawej strony

ko³a w kierunku jego œrodka, by zmniejszyæ ten obszar (patrz

rysunek 11.3).

7. Przesuñ przednie punkty kontrolne obu krzywych wzd³u¿ osi

Z, by nadaæ b³otnikowi nieznaczne zaokr¹glenie w kierunku

(nieistniej¹cego) okratowania wlotu ch³odnicy z przodu sa-

mochodu (patrz rysunek 11.4).

8. Przesuñ górne punkty kontrolne (z wyj¹tkiem tych, które zosta³y

w³aœnie przesuniête) nieznacznie wzd³u¿ osi Z, by zagi¹æ

b³otnik w kierunku maski (patrz rysunek 11.5).

Rysunek 11.3. Narzêdzie Proportional
Modification Tool znakomicie nadaje
siê nie tylko do translacji punktów
kontrolnych, ale tak¿e do skalowania;
w tym przyk³adzie nieco zmniejszamy
oraz zaokr¹glamy otwór na ko³o;
poszczególne punkty kontrolne
górnych krzywych powinny zostaæ
odpowiednio przeskalowane, 
aby powierzchnia obiektu 
pozosta³a nienaruszona

Rysunek 11.4. Oba przednie 
punkty kontrolne zosta³y przesuniête
w prawo, by wymodelowaæ 
zaokr¹glenie przedniej czêœci 
zderzaka w kierunku okratowania 
wlotu ch³odnicy

Rysunek 11.5. Dziêki nieznacznemu
przesuniêciu pozosta³ych punktów
kontrolnych boczna czêœæ b³otnika
zosta³a nieznacznie przechylona 
w kierunku maski (lewy rysunek)

Rysunek 11.6. Przednie górne punkty
kontrolne zosta³y przesuniête do ty³u,
po to, by przechyliæ b³otnik 
w kierunku maski samochodu
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9. Przesuñ przednie punkty kontrolne górnej krzywej nieznacznie

do ty³u, by nieznacznie nachyliæ b³otnik (patrz rysunek 11.6).

B³otnik jest jeszcze daleki od doskona³oœci, ale zwróæmy

uwagê, jak niewiele czasu zajê³o nam dotychczasowe modelowa-

nie. Prototyp ju¿ teraz wygl¹da jak b³otnik. Jednak¿e, po tych

wstêpnych modyfikacjach szybko oka¿e siê, ¿e istniej¹ ograni-

czenia zwi¹zane z wykorzystywaniem ³¹czonych powierzchni.

Krzywe poziome pozwalaj¹ wygodnie kontrolowaæ podstawowe

kszta³ty, ale brak jest mo¿liwoœci kontroli w pionie. Potrzebne s¹

krzywe pozwalaj¹ce zamodelowaæ charakterystyczne elementy,

np. ostr¹ krawêdŸ tu¿ nad ko³em. Poza tym, obie pionowe krawê-

dzie s¹ zupe³nie proste, choæ powinny cechowaæ siê ³agodnym

zaokr¹gleniem. Mo¿na by wstawiæ trzeci¹ krzyw¹ pomiêdzy

dwoma istniej¹cymi oraz utworzyæ now¹ powierzchniê, by uzys-

kaæ efekt zaokr¹glenia, ale by³by to bardzo okrê¿ny sposób roz-

wi¹zania problemu. Ca³kowita kontrola wygl¹du powierzchni w pio-

nie jest mo¿liwa tylko za pomoc¹ krzywych pionowych.

W nastêpnej czêœci wykorzystamy narzêdzie Square pozwa-

laj¹ce utworzyæ powierzchniê sk³adaj¹c¹ siê z czterech ograni-

czaj¹cych krzywych, które stykaj¹ siê z sob¹ lub przecinaj¹ siê.

Jeœli nie jest ono dostêpne w posiadanej wersji Maya, mo¿na wy-

korzystaæ narzêdzie Birail 2.

Przed usuniêciem p³aszczyzny warto j¹ zaznaczyæ i uwa¿nie

przyjrzeæ siê jej budowie oraz parametrom. P³aszczyzna sk³ada siê

z dwóch poziomych oraz kilku niemal równoleg³ych pionowych

krzywych. Jeœli którekolwiek z krzywych tworz¹cych powierzch-

niê przecinaj¹ siê, nale¿y to zmieniæ (patrz rysunek 11.7).

1. Usuñ p³aszczyznê.

2. Pos³uguj¹c siê narzêdziem EP Curve Tool utwórz dwie

nowe krzywe, które stykaj¹ siê z poziomymi krzywymi

(patrz rysunek 11.8).

Bardzo wa¿ne jest, by korzystaæ z opcji Curve Snapping

(przyci¹ganie krzywych) podczas tworzenia nowych krzywych

(nale¿y nacisn¹æ i przytrzymaæ klawisz Ctrl). Jest to jedyny

sposób upewnienia siê, ¿e krzywe rzeczywiœcie siê zbiegn¹. 

Rysunek 11.7. Podstawowy kszta³t
b³otnika sk³adaj¹cy siê z kilku 
pionowych oraz dwóch poziomych
krzywych

Rysunek 11.8 Dwie nowe krzywe
zosta³y utworzone za pomoc¹
czterech klikniêæ myszy; ³¹cz¹ one
koñce poprzednich krzywych
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Aby utworzyæ krzywe, wystarcz¹ w zupe³noœci dwa klikniêcia.

Krzywe powinny zbiegaæ siê w tym samym kierunku.

3. Zaznacz kolejno cztery krzywe (zgodnie z ruchem wskazówek

zegara lub w odwrotnej kolejnoœci) i zastosuj polecenie Square

z menu Surfaces, by utworzyæ now¹ powierzchniê. Po-

wierzchnia nie zostanie utworzona, jeœli krzywe nie spotkaj¹

siê. Nowa powierzchnia wygl¹dem przypomina t¹, która zos-

ta³a utworzona na pocz¹tku, ale tym razem mo¿na edytowaæ

pionowy kszta³t b³otnika.

4. Przesuñ oba œrodkowe punkty kontrolne tylniej krzywej (tej,

która jest z ty³u samochodu) poziomo, by zaokr¹gliæ krawê-

dzie b³otnika.

5. Przesuñ oba œrodkowe punkty kontrolne przedniej krzywej

(tej, która jest blisko ch³odnicy) nieznacznie do przodu, by

przednia czêœæ b³otnika równie¿ cechowa³a siê odpowiednim

zaokr¹gleniem (patrz rysunek 11.9).

Rysunek 11.9. Nowa powierzchnia
wymodelowana z czterech krzywych;
przesuniêcie dwóch œrodkowych
punktów kontrolnych przedniej 
krzywej sprawia, ¿e b³otnik jest
zaokr¹glony

Rysunek 11.10. Koniec drugiego
etapu projektowania prototypu:
powierzchnia przed usuniêciem

Warto zauwa¿yæ, w jaki sposób te niewielkie zmiany krzywiz-

ny maj¹ wp³yw na ca³¹ strukturê powierzchni. Jeœli zajdzie potrze-

ba przesuniêcia punktów kontrolnych na koñcu którejkolwiek

krzywej, warto pamiêtaæ, by przesun¹æ równie¿ odpowiadaj¹ce

punkty kontrolne stykaj¹cych siê krzywych – w przeciwnym

wypadku nie bêdzie mo¿na wygenerowaæ potrzebnej powierzchni.

Dobrym rozwi¹zaniem jest wspólne przesuniêcie odpowiednich

punktów kontrolnych przeciwnych krzywych, poniewa¿ zmiany
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tylko jednego boku maj¹ nieprzewidywalny wp³yw na kszta³t ca-

³oœci. Po usuniêciu powierzchni pozosta³e cztery krzywe w znacznie

lepszy sposób opisuj¹ kszta³t b³otnika ni¿ krzywe, które pozosta³y po

usuniêciu pierwszej powierzchni (patrz rysunek 11.10).

1. Usuñ powierzchniê.

2. PrzejdŸ do g³ównego obszaru roboczego.

3. Utwórz dwie nowe pionowe krzywe, które wychodz¹ od ko³a

samochodu i biegn¹ a¿ do górnej krzywej (patrz rysunek

11.11). Równie¿ w tym przypadku warto zastosowaæ opcjê

Curve Snapping oraz ograniczyæ tworzenie krzywych do

dwóch klikniêæ.

4. Prze³¹cz siê na widok perspektywiczny. Przesuñ dwa œrod-

kowe punkty kontrolne dwóch nowych krzywych wzd³u¿

osi Z, by wyrównaæ je wzglêdem innych pionowych krzy-

wych (patrz rysunek 11.12).

5. Usuñ zaznaczenie wszystkich krzywych.

6. Uruchom narzêdzie Birail 3+, wybieraj¹c polecenie Birail

3+ Tool z menu Surfaces > Birail.

Birail 3+ pozwala tworzyæ powierzchnie z dwóch krzywych

wiod¹cych. Liczba 3+ oznacza, ¿e pomiêdzy krzywymi

wiod¹cymi umieszcza siê trzy lub wiêcej profilowanych krzy-

wych. W tym przypadku krzywe wiod¹ce to dwie oryginalne

poziome krzywe, które s¹ powi¹zane z czterema pionowymi

krzywymi. Linia pomocnicza w lewej dolnej czêœci ekranu

pozwala ³atwiej œledziæ œcie¿kê. Ta linia umo¿liwia wybranie pro-

filowanych krzywych.

7. Zaznacz cztery pionowe krzywe i naciœnij Enter.

8. Zaznacz dwie poziome krzywe i naciœnij Enter.

W rezultacie otrzymaliœmy now¹ powierzchniê – ostatni¹ w tym

rozdziale (patrz rysunek 11.13). Powierzchnia ta ró¿ni siê bard-

zo od poprzednich. Wokó³ nowych pionowych krzywych widzi-

my kilka krzywych, które sprawiaj¹, ¿e powierzchnia b³otnika

jest mniej elegancka. Wkrótce ulegnie to zmianie.

Wprowadziliœmy œrodkowe krzywe profilowane, aby przy-

gotowaæ bardziej z³o¿on¹ strukturê, która czêsto wystêpuje 

w okolicy nadkola. Punkty kontrolne krzywych pionowych nie

Rysunek 11.11. Nowe krzywe 
pionowe utworzone za pomoc¹
narzêdzia EP Curve Tool
oraz opcji Curve Snapping

Rysunek 11.12. Przesuñ œrodkowe
punkty kontrolne w poziomie 
(do lewej), by nadaæ œrodkowej czêœci
zderzaka bardziej zaokr¹glony kszta³t

Rysunek 11.13. Powierzchnia 
sk³adaj¹ca siê z dwóch krzywych
wiod¹cych wygl¹da na mniej 
uporz¹dkowan¹ ni¿ poprzednie
powierzchnie, poniewa¿ na jej kszta³t
maj¹ wp³yw dodatkowe krzywe 
na jej œrodku
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wystarczaj¹ w tym przypadku do wygenerowania wystarczaj¹cej

liczby szczegó³ów. Jeœli otworzymy okno Attribute Editor z w³aœ-

ciwoœciami krzywych, zobaczymy, ¿e zosta³y one zbudowane za

pomoc¹ dwóch klikniêæ oraz dwóch punktów kontrolnych po-

œrodku. Konieczne jest przebudowanie krzywych w celu wsta-

wienia wiêkszej liczby punktów kontrolnych. Aby nie znieksz-

ta³ciæ geometrii, przebudujemy wszystkie pionowe krzywe w ten

sam sposób.

1. Zaznacz wszystkie cztery pionowe krzywe.

2. Wybierz polecenie Rebuild Curve z menu Curves, aby

otworzyæ okno z opcjami. Ustaw wartoœæ parametru Number

of Spans na 4 (patrz rysunek 11.14). Kliknij przycisk Rebuild.

Rysunek 11.14. Rekonstrukcja 
wszystkich krzywych profilowanych
pozwala wstawiæ wiêksz¹
liczbê szczegó³ów nad ko³em 

i wymodelowaæ charakterystyczn¹
ostr¹ krawêdŸ

Po przebudowaniu wszystkich pionowych krzywych po-

wierzchnia cechuje siê wiêksz¹ gêstoœci¹ definicji geometrii

poziomych ³at. Warto zauwa¿yæ, ¿e powierzchni nie trzeba prze-

budowywaæ, poniewa¿ natychmiast dostosowuje siê do nowych

atrybutów krzywej.

3. Wyœwietl wszystkie punkty kontrolne obu pionowych œrod-

kowych krzywych (tych, które zosta³y utworzone na koñcu)

w trybie komponentów (F8).

Rysunek 11.15. Przesuniêcie 
zaznaczonych punktów kontrolnych
na obu krzywych nieco w dó³
powoduje utworzenie 
charakterystycznej krawêdzi 
nad ko³em samochodu; krawêdŸ 
p³ynnie zanika w obu kierunkach,
poniewa¿ punkty kontrolne 
w przedniej oraz tylniej czêœci 
zosta³y rozmieszczone równomiernie
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4. W przypadku obu krzywych zaznacz czwarty punkt kontrol-

ny (licz¹c od do³u) (patrz rysunek 11.15).

5. Przesuñ te dwa punkty kontrolne nieco w dó³.

Magiczna chwila: Niewielkie przesuniêcie odpowiednich

punktów kontrolnych powoduje wymodelowanie po¿¹danej

krawêdzi nad ko³em samochodu. Mi³¹ funkcj¹ tego efektu jest

to, ¿e wypuk³oœæ stapia siê ³agodnie z karoseri¹, podobnie jak 

w prawdziwych samochodach. To ³agodne przejœcie jest zale¿ne

od interakcji pomiêdzy s¹siaduj¹cymi pionowymi krzywymi.

Dziêki tej dodatkowej geometrii mo¿na zwiêkszyæ liczbê

szczegó³ów w górnej czêœci pionowych krzywych (patrz

rysunek 11.16). Warto zbli¿yæ odpowiadaj¹ce punkty kontrolne,

jeœli to mo¿liwe oraz sprawdziæ w nowym oknie (byæ mo¿e 

w innym trybie cieniowania), jaki wp³yw ma przekszta³canie

krzywych na przebieg krzywych i powierzchni.

Rysunek 11.16. Przebudowa
powierzchni jest mo¿liwa 

dziêki licznym krzywym

Jeœli nie ma wystarczaj¹cej liczby punktów kontrolnych,

nale¿y ponownie zrekonstruowaæ przebieg krzywych. Kiedy

wszystko jest ju¿ gotowe, przystêpujemy do rekonstrukcji ca³ej

powierzchni. Dziêki temu krzywe zostan¹ równomiernie roz³o-

¿one.

1. Otwórz okno Attribute Editor z w³aœciwoœciami powierzch-

ni i zanotuj wartoœci wspó³rzêdnych U oraz V dla parametru

Number of Spans.

Za³ó¿my, ¿e te wartoœci to odpowiednio 17 i 4, co oznacza 

17 pionowych oraz 4 poziome krzywe tworz¹ce powierzchniê. 

W przypadku z³o¿onej powierzchni 4 to niewielka wartoœæ i nie

powinna byæ dodatkowo zmniejszania. Jednak¿e 17 to o wiele

wiêcej ni¿ potrzeba w tym przypadku, dlatego mo¿na zmniejszyæ

wartoœæ tego parametru mniej wiêcej o po³owê.
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2. Otwórz okno z opcjami polecenia pozwalaj¹cego na przebu-

dowê powierzchni: wybierz polecenie Rebuild Surfaces

|z menu Edit NURBS (patrz rysunek 11.17).

3. Zmieñ wartoœæ parametrów Number of Spans dla wspó³rzêd-

nych U i V. (W tym przyk³adzie wartoœæ wspó³rzêdnej U nale¿y

zmieniæ na 8 i zachowaæ istniej¹c¹ wartoœæ wspó³rzêdnej V).

4. Zakoñcz edycjê przez klikniêcie przycisku Rebuild.

Powierzchnia zosta³a odbudowana na podstawie prostszej 

i wyraŸniejszej dystrybucji krzywych tworz¹cych powierzchniê.

Jeœli brakuje jakichkolwiek szczegó³ów, które zosta³y wymodelo-

wane wczeœniej, cofnij ostatni¹ czynnoœæ i zrekonstruuj powierzch-

niê, zmieniaj¹c nieznacznie wartoœci wspó³rzêdnych U i V.

Krzywe s¹ teraz zbêdne i mo¿na je usun¹æ. Jeœli chcemy dalej

pracowaæ z krzywymi lub dodawaæ kolejne szczegó³y, wystarczy

zaznaczyæ cztery krzywe zlokalizowane na krawêdzi powierzch-

ni i korzystaj¹c z narzêdzia Square lub Birail 2, skonstruowaæ

now¹ powierzchniê z tych czterech krzywych. Nastêpnie warto

usun¹æ star¹ powierzchniê. G³ównym celem powinno byæ utwo-

rzenie jak najmniejszej liczby mo¿liwie najprostszych krzywych,

które pozwol¹ na wymodelowanie interesuj¹cej powierzchni.

Przed zrenderowaniem sceny warto zwiêkszyæ wartoœæ para-

metru Tesselation w oknie Attribute Editor z w³aœciwoœciami dla

danej powierzchni, by wyg³adziæ powierzchniê zderzaka. Cienie

ró¿nego rodzaju mo¿na znaleŸæ w bibliotece z cieniami. Zachêcam

równie¿ do samodzielnego wymodelowania cienia z pó³przez-

roczystym lakierem pokrywaj¹cym powierzchniê.

Rysunek 11.17. Okno pozwalaj¹ce na rekonstrukcjê
powierzchni jest podobne do okna rekonstrukcji 
krzywych; domyœlnie polecenie to tworzy prostsze,
bardziej równomiernie roz³o¿one powierzchnie

Rysunek 11.18. Gotowy b³otnik; potrzeba jeszcze drzwi,
maski oraz wlotu ch³odnicy 
(kolorowa ilustracja na wklejce)

Dla odmiany:
Czy korzysta³eœ kiedykolwiek 

z menu Find?


